The National Association of
Photoshop Professionals (NAPP) presents:

An in-depth look at Photoshop 7
The NAPP, publishers of Photoshop User magazine, bring you
this excerpt from a special Photoshop 7.0 supplement
created for members of the NAPP. The complete 32-page
supplement is included with the April/May 2002 issue of
Photoshop User magazine to keep our members on the
cutting edge of Photoshop education and news.
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For more Photoshop 7 info, including QuickTime video clips,
visit http://www.photoshopuser.com

NewFeatures

When I first heard that Adobe was going to announce
Photoshop 7.0, it really caught me off guard because
Photoshop 6 still felt so fresh to me that I couldn’t
imagine it was time for an upgrade. But then I looked
back at my calendar—sure enough, when 7.0 ships, it
will be about a year-and-half since 6.0 shipped. Once
I learned the upgrade was on its way, I was dying to
find out what features 7.0 would hold; and sharing those new
features with you is what this special 7.0 Supplement is all about.
In this feature, we’ll give you an overview of all the cool things that
have been added, enhanced, and improved, and in the rest of this
Supplement, we’ll teach you how to use these new features.

Adobe
Photoshop 7.0
THE BEST IMAGE-EDITING APPLICATION GETS EVEN BETTER

New Features Overview

photoshop user • 7.0 special supplement

■ BY SCOTT KELBY

8

A

fter a few months of Beta testing
Photoshop 7.0, we’ve realized that 7.0 is
a different kind of upgrade than 6.0 was.
When Adobe announced 6.0, it was a very visual
upgrade—as soon as you launched the program,
the Options Bar running across the top instantly
let you know things were going to be different.
There were interface changes, the floating
Brushes palette (that had been in Photoshop
since version 1.0) was gone, there were new
palettes, new icons were added to the Layers
palette, and it felt like a new environment.
Luckily, after just a few minutes in that environment, you realized 6 rocked, and that it was
another evolutionary step in the right direction.
But 7.0, while being another big step in the
right direction, won’t freak people out the way
6.0’s new interface did. In fact, it does a beautiful
job of building on the advances Adobe introduced in 6.0 to make 7.0 the most powerful, most
amazing, and most useful version of Photoshop
ever. But its power, changes, and improvements

are not as evident when you first launch the
program. In fact, when I first read the list of new
features, I thought, “Hey, these sound pretty
good,” but when I actually saw them in action,
I was pleasantly surprised at how much work
Adobe did to this upgrade, and how much better
7.0 is than my old favorite 6.0.
Another big difference between 6.0 and 7.0
is that 6.0 didn’t really have a big “gotta have it”
feature. Instead, it was a broad upgrade that
addressed a lot of issues and improved a lot of
areas, such as Layer Styles, Brushes, Options, and
things like that. But Photoshop 7.0 has at least
two huge “gotta have it” features (the Healing
Brush, and Mac OS X/Win XP compatibility, both
of which we’ll discuss in just a minute), along with
lots of other cool new features, enhancements,
and improvements.
I know—you’re ready to get to the features, so
we’ll dive right in and we’ll hit the first “gotta have
it” feature, then we’ll uncover all the other things
that make 7.0 the best version of Photoshop ever.

Photo, heal thyself
Photoshop 7.0’s new Healing Brush may
be the single coolest tool in Photoshop
ever and when you use it, all you can
do is shake your head and say, “How in
the world does it do that?” It’s that cool.
The Healing Brush is like the fountain of
youth for photographs of people—you
paint with it and it removes wrinkles and
other signs of aging. This is not just the
Clone Stamp tool set to Lighten mode;
this is light years beyond that, because it
recreates the skin texture in a way that’s
absolutely amazing. To see it in action is
nothing short of stunning and you can
use it and its companion tool, the Patch
tool, to do much more than just removing
wrinkles. It mends backgrounds with
scratches, removes dots, spots, and
much more. This tool is nothing short of
a retoucher’s dream, and if you retouch
photos, this tool will pay for itself the first
time you use it. Basically, when it comes
to retouching photos in Photoshop, this
tool changes everything. Make sure you
see our Healing Brush tutorial on page 16.
Mac OS X / Windows XP compatibility
If you’re a Macintosh user, the main
reason to upgrade to 7.0 for you may be
the fact that Photoshop 7.0 has been fully
Carbonized for Mac OS X, and it performs

beautifully. Mac users also get the added
benefit of the new Mac OS X interface
for Photoshop, which sports a new Aqualike Toolbox that really makes you feel
like you’re working on the “Photoshop of
the future.”
Windows XP users will not be disappointed either, as Photoshop 7.0 is fully
Win XP compatible, and it too sports a
slick new interface, which in some ways is
a more comprehensive visual update than
the Mac OS version. Check out our article
on page 24 for a look at the Mac OS X and
Win XP interfaces and what they bring
to the table.
7.0’s evolving Interface
Even when running Photoshop on
Mac OS 9.1 or higher or Windows
98/2000/ME/NT/XP, the first thing you’re
likely to notice aboutPhotoshop 7.0 is its
new high-tech Photoshop Toolbox, with
a gray appearance and redesigned tool
icons that now highlight in color when
you roll over them. Adobe carries this
rollover theme throughout many areas
of Photoshop with rollovers for many
buttons and tools giving you some
interactive feedback.
You’ll find a nice interface tweak in
the preview windows for Photoshop’s
filters. Those tiny little squares have been

replaced by huge previews that really
make you wonder, “Why didn’t they do
this before?”
Another interface tweak takes place
in the Layers palette, where four simple
buttons replace the checkboxes for Lock
Transparency, Image Pixels, Position,
and Lock All. Plus, Adobe has moved
the Fill amount (previously buried in the
Layer Blending Options dialog) near the
top of the palette.
I predict that my favorite interface
feature will also become one of your
favorites—the ability to customize your
own personal workspace and to set up
specific workspaces for specific tasks.
For example, if you like the Layers
palette open all the time on the rightcenter of your screen, with the Channels,
Paths, and History palette nested within,
and you like the Swatches, Color palette,
and Actions palette docked to the Palette
Well, you just set up the work area the
way you like it, go under the Window
menu, under Workspace, and choose
“Save Workspace,” and then give it a
name. Then, if someone else uses your
machine or if you just want to instantly
return to your ideal setup, you just
choose your personal “workspace” from
the Workspace list. It even remembers the
exact position of your palette, so if you
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Here’s a look at
Photoshop 7.0’s
interface, with its new
Toolbox, expanded
Brushes palette, and
Tool Options Bar.
You can also see the
“gotta have it” tool
of the year—the
Healing Brush.
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Photoshop’s
Toolbox has an
updated look, with
redesigned tool
icons that roll over
in color when you
move your cursor
over them.
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Gone from the 7.0 Layers palette
are the checkboxes for locking
attribute, replaced by buttons that
roll over as well. Plus, the Fill control (from the Blend Options) now
lives there too.
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like the Options Bar running along the
bottom of your work area rather than
across the top, it remembers that too.
Better yet, I find that when I’m
retouching, I use one setup, but when
I’m collaging I use a totally different set of
palettes, and yet another when designing
Web pages. You can set up Workspaces
for each and when you start each task,
you’re one menu command away from
instantly having Photoshop set up your
workspace the way that you like it. Plus,
it’s incredibly fast in its implementation.
Try this once and you’ll fall in love with it.
One cool improvement to the interface is the addition of Tool Presets,
which enable you to create your own
tool set-ups, with your own custom
Options settings. More on this later in
this article.
Another interface tweak in 7.0 is that
Adobe moved Extract and Liquify under
the Filter menu (where in my humble
opinion, they belonged all along).
You’ll find lots of little interface
improvements and tweaks all through 7.0,
such as access to more type controls in
the Character palette through one-click
buttons; a button in the Options Bar that
brings up related palettes; the addition of
a “Print one copy” command to the Mac
version’s File menu; the ability to now tile

Missed me? I’m back! The Floating
Brushes palette is back, but you
didn’t lose the convenient pop-down
one in the Options Bar either (you
get the best of both worlds). The
Brushes palette, collapsed to hide its
expanded view. (Its expanded view is
shown in the capture on the previous page.)

Now you can create
and save your own
custom workspaces,
so your desired
palettes, and even
their locations,
appear instantly.
A new pop-up list of commonly used document sizes
saves you time in the New Document dialog box.

open documents (rather than just cascading them as in previous versions); the ability to increase the size of the Curves dialog box (very helpful if you’re using a
monitor set at 1024x768 or higher); and
lots of very welcome tweaks throughout
that make 7.0 easier and more intuitive
to work with.
Power to the Brushes!
For many people, the most exciting
change may be the reappearance of the
floating Brushes palette (yippee!). When it
first appears, it’s quite a large expanded
palette showing you previews of the
different brush strokes, and it includes a
new area for editing the many new brushes
in Photoshop 7.0, many of which mimic
traditional brushes and offer more “paintlike” effects. However, if you just want the
old Brushes palette back, you can choose
to hide the expanded palette and return
to the pre-6.0 version of the Brushes
palette. If you do that though, you’ll be
missing another of this upgrade’s biggest
features, which is a totally new brush
engine that gives you creative and artistic
power that no previous version can rival.
For example, now you can scale the size
of ANY brush, using the Master Diameter
slider, which makes all those cool special
effects brushes that were lost on high-res

images, now suddenly usable. Another
feature that a lot of people will love in
the new Brushes palette is the Stroke
Thumbnails, which display both a small
thumbnail of the Brush tip and a preview
of its stroke right beside it. Adobe has
also included a number of new preset
brushes that you can load instantly. For
more on the Brush Engine, check out
our article on page 14.
Just Browsing
There may actually be another “gotta
have it” feature in 7.0 and that’s the addition of a new File Browsing feature (see
page 20). It’s a surprisingly robust feature
that lets you create, view, sort, categorize,
and quickly find images of all kinds, and it
reads any Meta data you have embedded
in the image as well. Perhaps best of all, it
automatically creates thumbnail previews
of your images—a big boon to digital
photographers grabbing images off their
cameras and card readers. I was fairly
surprised at the speed and power of this
new feature, and it quickly becomes an
indispensable tool. The downside is that
you get used to it so quickly, it makes
you cringe any time you access the old
“Open” dialog box (from the File menu)
that we’ve grown so accustomed to. Use
this once, and you’ll do your best to stay

Dramatically larger
filter previews help
take the guesswork
out of applying the
proper filter amounts.

away from the File menu and its outdated
Open dialog box.
Is that a typo, señor?
In the “Thank God they finally added
that” column comes the addition of a
high-powered spell checker, which not
only checks English spelling, but the
spelling of a host of other foreign languages as well, including Italian, German,
and Spanish, among others. Best of all, it
will check an entire paragraph of English
and still detect when a French word is
misspelled (Frasier and Niles have got
to love that). Très magnifique!
Custom tool settings—your way!
Okay, there’s one more feature that in
its own right is vying for the “gotta have
it” category—Tool Presets (see page 21).
This is big, Mondo-crazy big, because
not only can you set up your workspace
to your own custom layout, now you
can set up your tools to use the exact
options you want. For example, if you
usually use the Airbrush tool set to
Overlay mode at 15%, with a 35-pixel,
soft-edged brush—now you can have
Photoshop set that up for you with just
one click. In fact, it pretty much lets you
close the Toolbox altogether, because
now instead of using Photoshop’s

default settings, you’ll create your own
and only use the tools you want with
the settings you want, and you can
access them from a pop-down menu in
the Options Bar, or from its own new
floating palette. But there’s more—do
you usually crop images to 5x7", or 4x6"?
Create a Crop Tool Preset set at those
fixed sizes and now you’re one click
away. Do you like to create Type in
Minion font at 11 points with 15 leading
and a .15 first-line indent, left-justified,
with the tracking set at -30? You can
save that as a custom tool and use it
anytime—Photoshop remembers all the
settings! This one feature I believe will
intrinsically change the way we work in
Photoshop, and save time, money, keystrokes, and frustration.
Other cool stuff
Adobe added a new Pattern Maker
(which appears under the Filter menu)
that lets you create seamless patterns.
It’s great for creating backgrounds and
it has a built-in Pattern History that
stores your attempts and lets you view
and retrieve your favorite version.
Another great use for the Pattern
Maker is for photo-retouching backgrounds. When you need to replace
some brown grass or cracked sidewalk,

this baby can generate a seamless
pattern of the texture of your choice, and
then you can use the Pattern Stamp tool
to paint in fresh new concrete, grass, etc.
See the tutorial on page 18 for more info.
Adobe has made major improvements
to Photoshop’s Liquify feature. They
added a Zoom tool (thank God), Multiple
Undo, and Pan, and you can now see
the background image or selected layers
within your image, giving you more
control over your Liquify work. They also
introduced a new tool called Turbulence,
which does just what it sounds like—adds
turbulence to your image (great for making realistic smoke, fire, etc.) Perhaps the
slickest new Liquify feature is that you
can save the mesh you create. What that
means is huge—you can apply and tweak
a low-res image to your heart’s content—
save the mesh—then apply the exact
same mesh to a high-res image. This in
effect gives you a resolution-independent
Liquify. Very, very slick!
Another welcome feature is Adobe’s
Auto Color feature (which appears under
the Image menu) that helps your color
images look their best by looking at an
image’s highlights, midtones, and shadows, analyzes them, and tries to neutralize any color casts in those areas. It’s quite
an improvement on Auto Levels (which
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The new File Browser, with its sorting and categorizing capabilities, makes finding
images on your hard drive or on a digital camera a breeze.

Now you can create
presets for any tool, so
the tools you use most
often, set up the way
you want them, are just
one click away. Best of
all, they maintain your
desired Option Bar
settings so you can
Crop right to the size
you want, or have Type
presets that remember
all your font and paragraph attributes as well.
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A much-improved Web Gallery
offers more templates, with
better designs and more
options than ever before.
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Adobe has greatly improved Photoshop’s Picture Package
automation, with the ability to use more than one source
image and by adding advanced labeling options.
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affected both the dynamic range and
the color) and Auto Contrast (introduced in 6.0), which ignored the color
casts and just improved the dynamic
range. It’s a one-trick pony—there’s
nothing to learn—you just choose it
and it does its thing.
Another new feature (one that was on
my personal wish list) is that Adobe now
includes a pop-up list of New Document
sizes in the New Document window. You
can choose from Letter, Legal, 640x480,
468x60 and more—you just choose them
from the list. One word—amen!
Photographers, stop here
Adobe has improved two functions
aimed at photographers and they’re very
welcome changes. First, they’ve vastly
improved the Picture Package automation (found under the File menu) and
now let you have multiple images in the
same picture package (rather than just
one image, repeated at different sizes).
They’ve also updated Contact Sheet with
more text features. It now reads Meta
info, which can be used to label photos
and include copyright info, plus much
more. Also, they once again improved the
Web Gallery automation and now give
you more and better templates and more
control of your Web Gallery pages.

Making seamless backgrounds and textures
just got vastly easier with 7.0’s Pattern Maker.

These are all very necessary changes
and continue the evolution of these
once limited tools to where they’re
now becoming robust enough that even
professional photographers can no longer
ignore them.
Web designers, this is for you!
Web designers definitely didn’t get left
out in the upgrade as Adobe tweaked,
added, and improved a number of
Web features in both Photoshop and
ImageReady. First, there are several
improvements to Photoshop’s Save for
Web feature, including the ability to click
on a background color to make it transparent (shades of GIF89a, without having
to use a separate plug-in).
When it comes to type for the Web,
there’s another level of Anti-aliasing
called Sharp, which aids in type that’s
still readable at small sizes.
Another nice tweak is the ability
to sample a color in your Web image,
remap that color by double-clicking
on it (in the Color Table), and then
choosing a new color.
Adobe also tweaked its weighted
optimization feature, which used to just
apply to saved Alpha Channels but now
supports both Type and Vector Shapes,
and better yet, it will automatically create

New usable shape presets, including
numerous loadable sets, make the
Custom Shape tool more useful than ever.

the text and vector channels so you don’t
have to do it yourself in Photoshop first.
They also added a new Transparency
Dither that helps achieve partially transparent effects in your GIF Web graphics.
As far as ImageReady goes, Adobe
now calls it ImageReady 7.0 (rather
than 3.0, which was confusing, since
Photoshop was at 6.0). Many of
Photoshop’s improvements made their
way over to ImageReady (see page 30),
but there’s one major feature that’s
really noteworthy and that’s its new
Rollover palette, which centralizes the
authoring and management of rollovers,
image maps, and animations. Plus,
now you can see everything in your
document at once without having to
click slice by slice. There's also a new
Rollover state called “Selected State”
that allows you to create nav-bar-like
graphics without hand coding.
The bottom line?
It’s definitely upgrade time! I think
you’ll find that this upgrade is much
more than meets the eye, and there are
elements to it (such as the Tool Presets,
Workspace, File Browser, Healing Brush,
etc.) that will make your Photoshop life
easier, faster, and more fun. And isn’t
that what it’s all about. ■

